
Running the Cross-Cluster
Dictation Interlock tool
1. On the 6.5.1 Application Server where the

Relay service is running, open a command
prompt.

2. Type the following command:

net start StudyStatusRelayService

3. Exit the command prompt.

Taking a pre-migration system
snapshot
1. Log in as mvf.

2. In a terminal window, change to the
directory containing the migration_inventory
tool.

3. Type

./migration_inventory -s -d
database_name -U
database_user_name -P
database_password -D
Database_Server_host_name

4. To create a report file with this information,
type

./mig-reporter -t
system_inventory_tool

Stopping Connectivity Manager
queues
1. In the Connectivity Manager, open Service
Tools and click Queue Manager.

2. In the Queue List table, select the checkbox
beside each queue belonging to a device
with a DM Out or impax_report_server
component.

3. Click Stop.

Updating study status between
servers
1. Log in as oracle user on the production

Database Server, log into sqlplus as
dbadmin and type

create public database link travel
connect to dbadmin identified by
admin_password using
'traveling_server_name';

2. In a text editor such as vi, edit the
/var/opt/oracle/tnsnames.ora file to add the
traveling server.

3. Perform the report status update by typing
the following into sqlplus:

declare

the_counter number := 0;

cursor study_cursor is

select t.study_ref, s.status from
dosr_study s, dosr_study@travel t

where s.patient_id = t.patient_id and
s.accession_number =
t.accession_number

and s.status <> t.status;

begin

for study_record in study_cursor LOOP

update dbadmin.dosr_study@travel set
status = study_record.status where
study_ref = study_record.study_ref;

the_counter := the_counter +1;

if mod (the_counter, 100) = 0 then

commit;

end if;

end loop;

commit;

end;

/

4. Drop the link to the traveling server
database by typing the following in sqlplus:

drop public database link travel;

Redirecting studies to the
traveling server
Configure the modalities to redirect studies to
traveling server, so that they remain accessible
while the migration continues. How studies are
redirected is modality-specific and is not
documented in this publication.

Verifying unverified studies
1. In the 6.2 or later Administration Tools, on

the Daily tab, click Study Manager.

2. From the location list, select Failed
Verification.

3. Set other search criteria to Any value.

4. Click Refresh.

5. In the search results, select all studies.

6. To fix up the studies that have failed
HIS verification, click Fix All Studies.

7. Review the results presented in the dialog.

Storing unarchived studies
1. In the 6.2 or later Administration Tools, on

the Daily tab, click Study Manager.

2. From the location list, select Cached (or
another value that will return the unarchived
studies).

3. Set other search criteria to Any value (or
set to appropriate values).
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4. Click Refresh.

5. In the search results, select the studies to
archive.

6. Click Store to Archive.

7. To update the status of the selected studies,
click Refresh.

8. Ensure that all studies are archived.

Stopping SMMS server alerts
1. On the SMMS server, double-click the
Disable GSC Notifications icon.

2. Open the C:\agfa\config\emailcmd.cfg
file for editing.

3. Change the line enabled = 'true' to
enabled = 'false'.

4. Save the file and close it.

Dropping Heartlab triggers
1. On the Database Server, log in as oracle

user and using SQLPLUS, log in as user
dbadmin.

2. Type the following:

SQLPLUS> drop trigger
TRG_DOSR_STUDY_UPD;

SQLPLUS> drop trigger
TRG_DOSR_SERIES_UPD;

SQLPLUS> drop trigger
TRG_DOSR_OBJECT_UPD;

SQLPLUS> exit;

Stopping antivirus software
1. On a Windows server to upgrade, launch the

antivirus software.

2. Halt the scan operation according to the
vendor’s instructions.

Stopping all queues
1. Launch the Administration Tools and log in

as the administrator user.

2. On the Daily tab, select Job Manager.

3. Select All Queues.

4. Click Halt Queue.

Stopping services on the
Application Servers
1. On an Application Server, open the Windows

Administrative Tools and select Services.

2. In the list of services, highlight the World
Wide Web Publishing Service.

3. Click Stop.

4. Repeat steps 2 and 3 for the following
services:

a. IMPAX Distributed License
Manager

b. IMPAX Messaging Service

c. IMPAX App Server Data Manager

d. IMPAX Audit Event Log Manager

e. IMPAX Dicom Object Sender

f. AGFA HealthCare Service

Stopping IMPAX services on
AS300 servers
1. On an AS300 server, in Windows Explorer,

navigate to C:\mvf\bin.

2. Double-click stopall.bat.

3. Double-click removeall.bat.

Stopping IMPAX on AS3000
servers
1. Log into the AS3000 server as the root user.

2. To stop IMPAX, type

stop_impax

3. Then type

disable_impax

Disabling IMPAX crontab entries
1. Log into the Database Server as the mvf

user.

2. To open the crontab file, type crontab -e.

3. Check the file carefully for any entries
related to IMPAX.

4. Comment out any IMPAX entries that you
find.

5. Save and close the file.

Checking for the CLUI and ISQL
processes
1. Log into the Database Server as the mvf

user.

2. Type

psg clui

psg isql

3. If processes are running, record the PID
number from the returned header.

Stopping the CLUI and ISQL
processes
1. Log into the Database Server as the mvf

user.

2. Type

kill -9 PID_number

Ensuring that the CLUI and ISQL
processes are stopped
1. Log into the Database Server as the mvf

user.

2. Type

psg clui

psg isql

3. Ensure that nothing is returned.
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Shutting down the Database
Server
1. Log into the Database Server as the mvf

user.

or

When restaging a Database Server already
running Oracle 10.2.0.4.2, log in as the
oracle user.

2. To shut down the database, type

dbshutmvf

3. To shut down the listener, type

lsnrctl stop

4. To confirm that all IMPAX and Oracle
processes have stopped, type

psg mvf

psg ora

psg tns

5. Verify that, in each of these cases, nothing
is returned.

Storing a cold backup of the
database and other Oracle
configuration files
1. If using a NFS share to store the backup,

start the NFS service on the server where
the backup files will be stored.

On Solaris 10, type

su -

svcadm -v enable -r network/nfs/server

or

On Solaris 9, type

su -

cd /etc/rc3.d

./s15nfs.server start

2. To share the directory that the IMPAX server
will be writing to use a Unix text editor such
as vi. For example, type

su -

vi /etc/dfs/dfstab

3. Add the following line

share -F nfs -o rw,anon=0
path_to_backup_location_directory

4. Save and close the file.

5. On the IMPAX server, mount the share as
the root user. For example, type

mkdir /backup_location

mount -o rw,bg,hard,rsize=32768,
wsize=32768,vers=3,forcedirectio,nointr,
suid server_containing_backup:
absolute_path_to_backup_location_directory
/backup_location

6. As the root user, copy each appropriate file
listed to the backup location.

Removing System DSN entries for
Oracle ODBC drivers
1. On the AS300 server or the Application

Server, open the Windows Administrative
Tools.

2. Select Data Sources (ODBC).

3. Switch to the System DSN tab.

4. Select the mvf System Data Source.

5. Click Remove.

6. To confirm the removal, click Yes.

7. To save the changes and close the dialog,
click OK.

8. On the Application Server, repeat the
previous steps for the mvf_ora System
Data Source as well.

Increasing the tablespace size on
Solaris
1. Log into the Database Server as the mvf

user.

2. Start the database by typing

dbstartmvf

3. Start the listener. Type

lsnrctl start

4. Change to the /usr/mvf-mig6/bin
directory.

5. To see whether 2–3 GB of space is available
for the MVFL tablespaces, type

/usr/mvf/bin/monitor_update

/usr/mvf/bin/monitor_stats

6. If additional space is needed, to run the
monitor_add script, type

/usr/mvf/bin/monitor_add

7. To continue, type C.

8. Type the tablespace name, MVFL.

9. Type the path name for the data file.

10. Type the size of the file in megabytes,
2000.

11. Repeat these steps for the MVFLINDX, MVF,
MVFINDX, and UNDO tablespaces,
substituting the appropriate tablespace
name each time.

Upgrading to Oracle Server
10.2.0.4.2
1. Log into the Database Server as the root

user.

2. If using a software repository that is not on
the local machine, mount the repository.

3. Change to the /usr/mvf-mig6/bin
directory.

4. Type ./upgrade-oracle.

5. To confirm that the latest patches have been
applied, type

$ORACLE_HOME/OPatch/opatch
lsinventory

6. Type the path of the Oracle 10.2.0.4.2
software repository.
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7. Type y when prompted to upgrade Oracle
Server and when prompted to remove the
existing Oracle package.

8. If the following error message appears:

Unable to stop the cron process. Stop
it manually as user root in
/etc/init.d and execute ./cron stop
before re-running this script.

Manually disable the cron process. As the
root user, type

svcadm disable
svc:/system/cron:default

9. Type the path for the Oracle Flashback
location.

10. Type the Flashback location size.

Upgrading the primary Data Guard
server to 10.2.0.4.2
1. Log into the primary Database Server as the
root user.

2. If using a software repository that is not on
the local machine, mount the repository.

3. Change to the /usr/mvf-mig6/bin
directory.

4. Type ./upgrade-oracle-dg.

5. Type the path of the Oracle 10.2.0.4.2
software repository.

6. Confirm that you are upgrading the Primary
Database.

Upgrading the standby Data
Guard server to 10.2.0.4.2
1. Log into the standby Database Server as the
root user.

2. If using a software repository that is not on
the local machine, mount the repository.

3. Change to the /usr/mvf-mig6/bin
directory.

4. Type ./upgrade-oracle-dg.

5. Type the path of the Oracle 10.2.0.4.2
software repository.

6. Confirm that you are upgrading the Standby
Database.

Upgrading the IMPAX 6.2 or later
database data and schema to
IMPAX 6.5.1
1. Log into the Database Server as the oracle

user.

2. Start the listener by typing

lsnrctl start

3. Change to the /usr/mvf-mig6/bin
directory.

4. If upgrading from IMPAX 6.5, type

./database-upgrade-script

Otherwise, type

./database-upgrade-script -v {62 | 63
| 64}

5. Verify that the version_number returned is
correct—for example, that it says 62 if
upgrading from IMPAX 6.2. If so, press
Enter to continue.

If the version is not correct, type q and
press Enter, then repeat step 4 with the
correct version number specified.

6. When prompted for a report source, in most
cases, type UNKNOWN. If using a
queryable RIS and multiple Connectivity
Managers, type the value used for the
Connectivity Manager issuer_of_* and
mcf_bls_report_workflow domain_id
fields.

7. Respond appropriately to other prompts that
appear.

Checking the upgrade status
1. On the Database Server, log in as the oracle

user and open the log file
/usr/mvf-mig6/data/logs/
migrate_database_to6.5.log.

2. Ensure that Migration Complete
Successful appears at the end of the log
file.

3. If this message does not appear, something
went wrong with the upgrade.

a. Review the rest of the log file to see
where the upgrade failed.

b. Solve the problem.

c. Rerun the upgrade script.

Upgrading the Oracle Data Guard
package
1. Log into the primary Database Server as the
root user.

2. Change to the IMPAX software repository
directory.

3. To remove the existing package, type
pkgrm IMPAXoradg.

4. Change to the
IMPAX_R6.5.1-build_number directory.

5. Type pkgadd -d . IMPAXoradg.

6. To verify that the upgraded package was
installed, type pkginfo -l IMPAXoradg.

7. Repeat all previous steps on the standby
Database Server.

Upgrading Solaris 10 AS3000
components to IMPAX 6.5.1
If upgrading IMPAX servers on Solaris 10, run the
cluster upgrade process to upgrade the Database
Server, AS3000 (Solaris) Network Gateways, and
AS3000 (Solaris) Archive Servers to IMPAX 6.5.1.
This applies to both single-host and dedicated
Database Server configurations.

If you are replacing the existing Database Server
with a new server, first back up the database files.
After installing the IMPAX 6.5.1 server software
on the new server, copy the backed-up database
files from the previous release of IMPAX onto the
new server.
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Installing Solaris 10 patches
1. Log into the Solaris support website using

your maintenance agreement credentials.

2. Under Patches and Updates, select the
Solaris 10 patch set.

3. Review the Readme file associated with this
patch set and make note of the password
which is needed to run the installation script.

4. Download the patch file to a directory of
your choice, such as the /agfa directory.

5. Log in as root and change to the directory
containing the patch file. (Mount the
location, if necessary.)

6. Unzip the patches. Type

unzip -q 10_Recommended.zip

7. Delete the 10_Recommended.zip file. Type

rm 10_Recommended.zip

8. Change to the 10_Recommended/
directory.

9. Switch to single-user mode by typing init s
and providing the root password.

10. Run the patch installation script. Type

./installcluster password

11. When the process is complete, reboot the
server. Type

shutdown -y -i6 -g0

12. When the server is restarted, in a browser,
go to the Solaris support website again.

13. Under Patches and Updates, select the J2SE
Solaris 10 patch set.

14. Review the Readme file associated with this
patch set.

15. Download the patch file to the same
directory as the previous patch.

16. Change to the directory containing the patch
file. (Mount the location, if necessary.)

17. Unzip the patches. Type

unzip -q
J2SE_Solaris_10_Recommended.zip

18. To delete the
J2SE_Solaris_10_Recommended.zip file,
type

rm J2SE_Solaris_10_Recommended.zip

19. Change to the
J2SE_Solaris_10_Recommended/
directory.

20. Switch to system administrator mode by
typing init s and providing the root
password.

21. Execute the patch installation script. Type

./install_cluster

22. When the patch installation is complete,
reboot the server. Type

shutdown -y -i6 -g0

Upgrading a Solaris server to
Oracle Client 10.2.0.4.0
1. On the server running the Oracle Client, log

in as root user and change to the
/usr/mvf-mig6/bin directory.

2. Type ./upgrade-oracle

3. When prompted, type the path to the Oracle
10.2.0.4.0 software repository.

4. If the following error message appears:

Unable to stop the cron process. Stop
it manually as user root in
/etc/init.d and execute ./cron stop
before re-running this script.

Manually disable the cron process. As the
root user, type

svcadm disable
svc:/system/cron:default

Verifying that Solaris patches are
installed
1. Log in as the root user.

2. Change to the root directory.

3. Type

showrev -p

4. Check whether the
Sun_rec_patches_installed file exists.

5. If the file does not exist, type the following
command:

touch .Sun_rec_patches_installed

Running the Trust Tool and
cluster upgrade
1. On the Solaris 10 server hosting the

repository:

a. Log in as user root.

b. Modify the /etc/ssh/sshd_config file by
setting the parameter PermitRootLogin
to yes.

c. To restart the ssh daemon, type
svcadm restart ssh.

2. On the repository machine, log in as user
root.

3. Change to the software_repository_path
directory.

4. Type

./trust_tool

5. Select option a - Build File
/var/tmp/mvftrust/hosts.cluster.

6. Select option q - Quit.

7. In a text editor such as vi, edit the
/var/tmp/mvftrust/hosts.cluster file and
remove the names of any non-AS3000
server from the file (for example, names of
Application Servers, AS300 Network
Gateways, and so on).

8. Change to the software_repository_path
.

9. Type

./trust_tool

10. Select option b - Establish Trust Relation
with Target Hosts.
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11. Provide the passwords (for the root user)
requested by the script.

12. If you receive the error message WARNING:
POSSIBLE DNS SPOOFING DETECTED! with
several lines of text and FAILED to
generate keys on host: <host_name> at
the end:

a. Make a backup copy of the
/.ssh/known_hosts file.

b. Open the /.ssh/known_hosts file in a
vi or other text editor, go to the
beginning of the line containing the
host_name specified in the error
message, delete the offending line,
and save the file.

c. Run ./trust_tool and select option b
again.

13. Change to the software_repository_path
.

14. Type

./trust_tool

15. Select option c - Check Trust Relation
with Target Hosts.

16. Copy the file
/var/tmp/mvftrust/hosts.cluster to
/hosts.cluster.

17. Ensure that the name of the software
repository machine is on the list. If it is not,
add it and save the file.

18. If you are logged in as the oracle user on
any machines in the cluster (the machines
are listed in the hosts.cluster file), log out
now.

19. Change to the software_repository_path
.

20. Type

./cluster_install upgrade

21. At the prompt:

Is it OK to shutdown the entire
cluster at this time? [yes,no,?,q]

type yes.

22. At the prompt:

Is it OK to start up the entire
cluster at this time? [yes,no,?,q]

type yes.

23. For security, disallow the remote login as
root on the repository machine and targets.
On the repository machine and on each
Solaris target machine:

a. Log in as user root.

b. Modify the /etc/ssh/sshd_config file by
setting the parameter PermitRootLogin
to no.

c. To restart the ssh daemon, type
svcadm restart ssh.

Testing the AS3000 Database
Server upgrade
1. Log into the Database Server as the oracle

or service user.

2. Change to the /usr/mvf/bin directory.

3. Type

ldd mvf-* | grep -i "file not found"

4. Confirm that error messages such as File
not found do not appear.

If any of the libraries are missing, contact
Agfa support for emergency recovery
processes.

5. Verify that CLUI works.

Upgrading Solaris 9 AS3000
components to IMPAX 6.5.1
To complete the upgrade of IMPAX AS3000
stations on Solaris 9, including the Database
Server and any Archive Servers or Network
Gateways, the servers must be restaged with
Solaris 10 and IMPAX 6.5.1.

Before the servers are restaged, the Database
Server is shut down again and another cold
backup of the database is performed.

After the restaging, the backup of the Oracle
database is restored on the newly staged
Database Server.

For Oracle Data Guard Database Servers, both
the primary and standby servers must be restaged
and have their backups restored.

Shutting down the Database
Server
1. Log into the Database Server as the mvf

user.

or

When restaging a Database Server already
running Oracle 10.2.0.4.2, log in as the
oracle user.

2. To shut down the database, type

dbshutmvf

3. To shut down the listener, type

lsnrctl stop

4. To confirm that all IMPAX and Oracle
processes have stopped, type

psg mvf

psg ora

psg tns

5. Verify that, in each of these cases, nothing
is returned.

Storing a cold backup of the
database and other Oracle
configuration files
1. If using a NFS share to store the backup,

start the NFS service on the server where
the backup files will be stored.

On Solaris 10, type

su -

svcadm -v enable -r network/nfs/server

or

On Solaris 9, type
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su -

cd /etc/rc3.d

./s15nfs.server start

2. To share the directory that the IMPAX server
will be writing to use a Unix text editor such
as vi. For example, type

su -

vi /etc/dfs/dfstab

3. Add the following line

share -F nfs -o rw,anon=0
path_to_backup_location_directory

4. Save and close the file.

5. On the IMPAX server, mount the share as
the root user. For example, type

mkdir /backup_location

mount -o rw,bg,hard,rsize=32768,
wsize=32768,vers=3,forcedirectio,nointr,
suid server_containing_backup:
absolute_path_to_backup_location_directory
/backup_location

6. As the root user, copy each appropriate file
listed to the backup location.

Completing the restaging of the
AS3000 stations
1. Install and configure the Database Server,

restaging it with Solaris 10 and IMPAX 6.5.1.

2. Install and configure any other AS3000
servers, such as Archive Servers or Network
Gateways.

3. Shut down the Database Server again,
stopping all IMPAX and Oracle processes.

4. Restore the database by copying all the
database files from the previous cold backup
to the newly staged Database Server. (For
Oracle Data Guard Database Servers,
restore the backups on both the primary and
the standby servers.)

5. Check and restart the database after
restaging.

or

Check and restart the Oracle Data Guard
servers.

Copying the backed-up database
files to a new or restaged
IMPAX 6.5.1 server
1. On the new IMPAX 6.5.1 Database Server,

stop all IMPAX processes. As the root user,
type

stop_impax

2. Stop all Oracle processes. As the mvf user
or oracle user (if running IMPAX 6.4 or
later), type

lsnrctl stop listener

lsnrctl stop listener_public (for Oracle
Data Guard server)

dbshutmvf

3. Log in as root and change to the /dbase
directory.

4. To remove all the database files in the
directory, type

rm -f data1/*

5. Repeat the previous step for any
subdirectories. Be sure to delete only the
files—leave the directory structure intact.

6. Restore every file from the backup location.
If a backup is stored on a NFS share, first
mount the share. As the root user, type

mount -o rw,bg,hard,rsize=32768,
wsize=32768,vers=3,forcedirectio,nointr,
suid server_containing_backup:
absolute_path_to_backup_location_directory
/backup_location

7. Ensure that all copied files are owned by the
oracle user, with the exception of the cache
directory, which must be owned by
mvf:mitra. To change the ownership, log in
as the root user, and type

chown -R oracle:dba
file_or_directory_name

Checking and restarting the
database after restaging
1. Confirm that all restored files have

oracle:dba ownership.

2. Start the database and confirm that no
errors appear.

3. Reboot the Database Server.

Checking and restarting the
database after restaging, for
Oracle Data Guard
1. Start up Oracle on both the primary and

standby Database Servers.

a. As the oracle user, type sqlplus as
/ sysdba

b. At the sql prompt, type startup
mount

c. Confirm that there are no errors on
the console.

2. Start the listener on both Database Servers.

a. On the primary server, as the oracle
user, type

lsnrctl start listener

lsnrctl start listener_public

b. On the standby server, as the oracle
user, type

lsnrctl start listener

c. After a few seconds, to list both the
private and public listener processes,
type

psg tns

3. Check the Data Guard configuration.

a. On the primary server, as the oracle
user, type

dgmgrl sys/stayout@mvf1

b. At the DGMGRL prompt, type

show configuration
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c. Confirm that SUCCESS is reported.

d. To quit, type exit.

4. Confirm that there are no problems with the
standby archive logs. On the primary server,
as the oracle user, type

check_standby

5. Confirm that clui can connect to the
database. On the primary server, as the
oracle user, type

clui

6. To exit clui, type exit.

7. Reboot both the primary and standby
Database Servers.

8. After the servers have rebooted, start the
public listener on the primary server.

Upgrading an IMPAX 6.5 AS3000
cluster to IMPAX 6.5.1
These tasks apply only when upgrading an AS3000
cluster already on IMPAX 6.5.

Upgrading the IMPAX 6.2 or later
database data and schema to
IMPAX 6.5.1
1. Log into the Database Server as the oracle

user.

2. Start the listener by typing

lsnrctl start

3. Change to the /usr/mvf-mig6/bin
directory.

4. If upgrading from IMPAX 6.5, type

./database-upgrade-script

Otherwise, type

./database-upgrade-script -v {62 | 63
| 64}

5. Verify that the version_number returned is
correct—for example, that it says 62 if
upgrading from IMPAX 6.2. If so, press
Enter to continue.

If the version is not correct, type q and
press Enter, then repeat step 4 with the
correct version number specified.

6. When prompted for a report source, in most
cases, type UNKNOWN. If using a
queryable RIS and multiple Connectivity
Managers, type the value used for the
Connectivity Manager issuer_of_* and
mcf_bls_report_workflow domain_id
fields.

7. Respond appropriately to other prompts that
appear.

Checking the upgrade status
1. On the Database Server, log in as the oracle

user and open the log file
/usr/mvf-mig6/data/logs/
migrate_database_to6.5.log.

2. Ensure that Migration Complete
Successful appears at the end of the log
file.

3. If this message does not appear, something
went wrong with the upgrade.

a. Review the rest of the log file to see
where the upgrade failed.

b. Solve the problem.

c. Rerun the upgrade script.

Upgrading the Oracle Data Guard
package
1. Log into the primary Database Server as the
root user.

2. Change to the IMPAX software repository
directory.

3. To remove the existing package, type
pkgrm IMPAXoradg.

4. Change to the
IMPAX_R6.5.1-build_number directory.

5. Type pkgadd -d . IMPAXoradg.

6. To verify that the upgraded package was
installed, type pkginfo -l IMPAXoradg.

7. Repeat all previous steps on the standby
Database Server.

Running the Trust Tool and
cluster upgrade
1. On the Solaris 10 server hosting the

repository:

a. Log in as user root.

b. Modify the /etc/ssh/sshd_config file by
setting the parameter PermitRootLogin
to yes.

c. To restart the ssh daemon, type
svcadm restart ssh.

2. On the repository machine, log in as user
root.

3. Change to the software_repository_path
directory.

4. Type

./trust_tool

5. Select option a - Build File
/var/tmp/mvftrust/hosts.cluster.

6. Select option q - Quit.

7. In a text editor such as vi, edit the
/var/tmp/mvftrust/hosts.cluster file and
remove the names of any non-AS3000
server from the file (for example, names of
Application Servers, AS300 Network
Gateways, and so on).

8. Change to the software_repository_path
.

9. Type

./trust_tool

10. Select option b - Establish Trust Relation
with Target Hosts.

11. Provide the passwords (for the root user)
requested by the script.

12. If you receive the error message WARNING:
POSSIBLE DNS SPOOFING DETECTED! with
several lines of text and FAILED to
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generate keys on host: <host_name> at
the end:

a. Make a backup copy of the
/.ssh/known_hosts file.

b. Open the /.ssh/known_hosts file in a
vi or other text editor, go to the
beginning of the line containing the
host_name specified in the error
message, delete the offending line,
and save the file.

c. Run ./trust_tool and select option b
again.

13. Change to the software_repository_path
.

14. Type

./trust_tool

15. Select option c - Check Trust Relation
with Target Hosts.

16. Copy the file
/var/tmp/mvftrust/hosts.cluster to
/hosts.cluster.

17. Ensure that the name of the software
repository machine is on the list. If it is not,
add it and save the file.

18. If you are logged in as the oracle user on
any machines in the cluster (the machines
are listed in the hosts.cluster file), log out
now.

19. Change to the software_repository_path
.

20. Type

./cluster_install upgrade

21. At the prompt:

Is it OK to shutdown the entire
cluster at this time? [yes,no,?,q]

type yes.

22. At the prompt:

Is it OK to start up the entire
cluster at this time? [yes,no,?,q]

type yes.

23. For security, disallow the remote login as
root on the repository machine and targets.
On the repository machine and on each
Solaris target machine:

a. Log in as user root.

b. Modify the /etc/ssh/sshd_config file by
setting the parameter PermitRootLogin
to no.

c. To restart the ssh daemon, type
svcadm restart ssh.

Testing the AS3000 Database
Server upgrade
1. Log into the Database Server as the oracle

or service user.

2. Change to the /usr/mvf/bin directory.

3. Type

ldd mvf-* | grep -i "file not found"

4. Confirm that error messages such as File
not found do not appear.

If any of the libraries are missing, contact
Agfa support for emergency recovery
processes.

5. Verify that CLUI works.

Updating odbc.ini after upgrading
an AS3000 Network Gateway or
Archive Server
1. On an AS3000 Network Gateway or Archive

Server station, log in as the root user.

2. Change to the /usr/mvf/odbc32v52
directory.

3. In a text editor, open the odbc.ini file.

4. In the [MVF] section, update the
AlternateServers attribute (it may be initially
blank) with the standby server name (a fully
qualified domain name may be used). For
example:

5. Save the file and close it.

6. Repeat the steps for any other AS3000
Network Gateway or Archive Server station.

Migrating a cache volume from a
flat to a hierarchical structure
1. At a command prompt on the system where

the cache volume is local, type

cache_migration.exe parameters
(Windows)

or

cache-migration parameters (Solaris,
logged in as mvf user)

Restarting SMMS server alerts
1. On the SMMS server, double-click the
Enable GSC Notifications icon.

2. Open the file
C:\agfa\config\emailcmd.cfg for editing.

3. Change the line enabled = 'false' to
enabled = 'true'.

4. Save the file and close it.

Re-enabling IMPAX crontab
entries
1. Log into the Database Server as the oracle

or service user.

2. To open the crontab file, type crontab -e.

3. Locate all entries related to IMPAX that have
been commented out.

4. Remove the # marks to re-enable these
entries.

5. Save and close the file.

Re-enabling archive logging
1. Log into the Database Server as the oracle

user.

2. Type the following commands:

mvf@os1spar:/usr/mvf$ sqlplus /nolog

SQL> connect /as sysdba

SQL> shutdown immediate
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SQL> startup mount exclusive

SQL> alter database archivelog;

SQL> alter database open;

SQL> archive log list;

SQL> exit;

Performing a warm backup of the
database
1. Log into the Database Server as the oracle

user.

2. If backing up to tape, record the date on the
tape jacket and insert the tape into the tape
drive.

3. Change to the /usr/mvf directory.

4. To reconfigure the database, type

configure_backup

5. Type runbackup

Generating the portable password
file
1. Log into the AS3000 Database Server as the
root user.

2. Change to the /usr/mvf directory.

3. To export the passkey for installing IMPAX
on remote machines, type

./bin/passkey -M EXPORT -k
temporary_password

4. To copy the portable password file from the
Database Server to the target server, type

scp /usr/mvf/mvf.portable.psd
service@target_host_name:/usr/mvf/
mvf.portable.psd

5. When you are finished copying the password
file to the target servers, delete
/usr/mvf/mvf.portable.psd from the
Database Server.

Installing the mvf license key on
a Solaris server
1. Match up the correct license key with the

machine’s MAC address.

2. Change to the /usr/mvf directory.

3. Copy the license key file to the mvf directory
on the hard drive.

4. Rename the license key file to:

mvf.lic

Installing the archive license key
on a Solaris server
1. Match up the correct license key with the

machine’s MAC address.

2. Change to the /usr/mvf directory.

3. Copy the license key file to the mvf directory
on the hard drive.

4. Rename the license key file to:

mvfarch.lic

Installing and starting
Compressor
If lossy compression was not enabled when IMPAX
was installed, and you want to enable it now, you
must manually install and start the Compressor
Scheduler package on the Database Server (or
single-host server). For instructions, refer to
“Installing Compressor Scheduler manually” (topic
number 6969) in the IMPAX 6.5.1 AS3000
Installation and Configuration Guide.

The Compressor files are already installed on
those systems with the IMPAXmvfc package (such
as Network Gateways and Archives); however,
Compressor is not actively running and must be
manually started, if required. For instructions,
refer to “Starting Compressor manually” (topic
number 6925) in the IMPAX 6.5.1 AS3000
Installation and Configuration Guide.

Upgrading Windows Server 2003
to Windows Server 2003 SP2
1. Connect to the network or computer where

you want to create the distribution folder.

2. In the shared folder, create a distribution
folder for the service pack.

3. Copy
WindowsServer2003-KB914961-SP2-XXX-LLL.exe
into the distribution folder.

4. Open a command prompt.

5. To extract the files, type the following:

WindowsServer2003-KB914961-SP2-XXX-
LLL.exe /X:[distribution_folder_path]

6. To install the service pack from a remote
shared distribution folder, run Update.exe.

7. Follow the instructions in the Setup Wizard.

8. When the installation process is complete,
restart the computer.

Uninstalling the previous version
of Oracle Client
1. Select Start > All Programs > Oracle -
ohome > Oracle Installation Products
> Universal Installer.

2. Click Deinstall Products.

3. In the Inventory dialog on the Contents tab,
select the OraClient10_home1 checkbox,
where home1 can be any text.

4. Click Remove.

5. In the Confirmation dialog, to confirm the
uninstall, click Yes.

6. After the uninstall is complete, to close the
Universal Installer, click Close, then Cancel.

7. Open the Windows Administrative Tools and
select Services.

8. Select the Distributed Transaction
Coordinator service. If it started, click Stop
to stop it.
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9. From Windows Explorer, delete the
drive_letter:\oracle directory.

10. From Windows Explorer, delete the
C:\Program Files\Oracle directory.

11. Run regedit and delete the
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
key.

12. Restart the computer.

Installing and configuring the
Oracle 10g Client for Windows
1. Insert the IMPAX Oracle for Windows 32-bit

DVD.

2. From the DVD drive, run setup.bat.

3. At the Install Oracle "client" or
"server"? prompt, type client.

4. At the Hostname of the Oracle server
[] ? prompt, type the correct host name of
the IMPAX Database Server.

5. At the What machine is the repository
host? [localhost] prompt, if it is the
localhost, press Enter. Otherwise, specify
the appropriate IP address.

6. At the Where is the software
repository? prompt, if installing from the
DVD drive on F, press Enter. Otherwise,
type the DVD drive or software repository
directory.

7. At the Where is the temporary work
directory? [ C:\cygwin\temp] ? prompt,
click Enter to accept the default location.
Otherwise, type the directory to use.

8. After the Oracle installation complete
message appears, restart the server.

Upgrading to the 10.2.0.4 version
of the Oracle Client for Windows
1. Insert the Oracle on Windows 32-bit DVD.

2. Open a command prompt.

3. Change to the C:\mvf-mig6\bin directory.

4. Type bash upgrade-oracle
location_of_DVD_drive_or
_Oracle_software_repository

5. When you see the message Ready to
upgrade Oracle using repository Oracle
software location. Do you want to
proceed? [y/n], verify that the oracle
software location is correct. If the location
is correct, type y and press Enter.

Setting up a connection to the
Oracle database
1. If the Net Configuration Assistant is not

open, select Start > All Programs >
Oracle - ohome > Configuration and
Migration Tools > Net Configuration
Assistant.

2. In the Oracle Net Configuration Assistant
Welcome dialog, select Local Net Service
Name configuration and click Next.

3. If the Naming Methods Configuration dialog
appears, select Local Naming. Click Next.

4. In the Net Service Name Configuration
screen, select Add. Click Next.

5. In the Service Name field, type MVF. Click
Next.

6. From the list of protocols, select TCP. Click
Next.

7. In the TCP/IP dialog, type the hostname of
the Oracle server.

8. Accept the default port number (1521). Click
Next.

9. Select Yes, perform a test. Click Next.

10. Click Change Login.

11. In the Username field, type mvf, and type
the password for the mvf user.

12. Click OK.

13. Click Next.

14. In the Net Service Name field, ensure that
MVF.world appears. Click Next.

15. If you do not want to add a net service name
for RIS, select No. Click Next.

or

To add a net service name for RIS, at the
prompt to configure another net service
name, select Yes. Click Next. Then repeat
all previous steps using a different service
name (for example, qprod), as well as a
different host name, login, and net service
name (for example QPROD.WORLD).

16. In the Net Service Name Configuration
Complete dialog, click Next.

17. In the Naming Methods Configuration
Complete dialog, click Next.

18. To close the Net Configuration Assistant
dialog, click Finish.

Reconfiguring ODBC data source
names
1. Open the Windows Administrative Tools.

2. Select Data Sources (ODBC).

3. Switch to the System DSN tab.

4. Click Add.

5. In the Create New Data Source dialog, select
Oracle in Oracle_instance_name

6. Click Finish.

7. In the Data Source Name field, type mvf.

8. Type a description, if needed.

9. In the TNS Service Name field, type
MVF.world.

10. In the User Name field, type mvf.

11. To save the changes and close the dialog,
click OK.

12. To save the new sources and exit the ODBC
Data Source Administrator dialog, click OK.

13. If reconfiguring the Application Server,
repeat the previous steps for the mvf_ora
DSN as well.
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Upgrading to Internet Explorer 7
1. Launch Internet Explorer on a computer

connected to the Internet.

2. Go to

http://www.microsoft.com/windows/
internet-explorer/ie7/

3. From this page, you can either download
Internet Explorer 7 or order it on CD.

4. Once you have obtained the software, run
it on each server that needs upgrading.

5. To install the software, follow the on-screen
prompts.

Retrieving the portable password
file from the target server
1. On the server (Application Server, Curator,

Network Gateway, or Archive Server), open
a command prompt.

2. Type

scp
service@target_host_name:/usr/mvf/
mvf.portable.psd
/cygdrive/c/mvf.portable.psd

3. Exit the command prompt.

Recording the names of
previously installed IMPAX AS300
software packages
1. On the IMPAX 6.4 or later server, open

Control Panel.

2. Select Add or Remove Programs.

3. Select AGFA IMPAX AS300 and click
Change.

4. After the installer launches, click Modify.

5. Click Next.

6. Make note of the installed packages.

To record the names of previously installed IMPAX 6.2
or 6.3 AS300 software packages

1. On the IMPAX 6.2 or 6.3 Windows server to
upgrade, select Start > Run.

2. In the Open field, type regedit and click
OK.

3. In the Registry Editor, select
HKEY_LOCAL_MACHINE\SOFTWARE\Mitra
Imaging Inc. and
HKEY_LOCAL_MACHINE\SOFTWARE\Mitra
and make note of the installed packages.

Uninstalling the previous IMPAX
software packages
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Under Currently installed programs, select
Agfa IMPAX 6.2 version , Agfa
IMPAX 6.3 version , or Agfa
IMPAX AS300 (used for IMPAX 6.4 and
later).

4. Click Change/Remove.

or

For uninstalling IMPAX 6.4 and later, click
Remove.

5. When prompted, type your name (minimum
three characters). Click Next.

6. In the Confirmation dialog, click OK or Yes.

7. On the Maintenance Complete screen, click
Finish.

8. Restart the server.

Installing the IMPAX 6.5.1 AS300
Network Gateway and Archive
Server packages
1. Insert the IMPAX AS300 DVD.

2. Navigate to D:\programs\mvf and
double-click as300-installer.exe.

3. Type your name (minimum three
characters).

4. On the Welcome screen, click Next.

5. On the Select features screen, all Default
Packages are selected. Clear the checkboxes
of any packages that should not be installed.

6. Clear the Database Packages checkbox.

7. For Archive Servers, select the Archive
Package label. The MVFhsm is the only
archive package listed and is selected by
default. If not using an HSM archive, clear
the MVFhsm checkbox; otherwise, keep it
selected.

For dedicated Network Gateway servers,
clear the Archive Packages checkbox.

8. Select the Optional Packages label.

9. Select any optional packages that should be
installed, and clear the other checkboxes.

10. Click Next.

11. If installing a Network Gateway or Archive
Server/Network Gateway combination,
browse to the location of the MVF license
file and click OK.

12. If installing an Archive Server or Archive
Server/Network Gateway combination,
browse to the location of the MVF archive
license file and click OK.

13. Browse to the location of the portable
password file and click OK.

14. Type the temporary password used to create
the portable password file and click Next.

15. On the Summary screen, click Next.

16. After all the packages have been installed,
click Yes, I want to restart my computer
now.

Installing and configuring Store
and Remember archiving
Some sites may want to have their studies
mirrored at another site through PACS Store and
Remember archiving. This mirroring protects
against loss of data and allows studies from one
PACS to be viewed at another. This can be
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achieved effectively using the PACS Archive
Provider (PAP).

For instruction on installing and configuring a
PACS Archive Provider, refer to “Configuring a
PACS Archive Provider (PAP)” (topic number
11586) in the IMPAX 6.5.1 AS300 Installation
and Configuration Guide.

Upgrading the Application Server
from a previous version
Upgrade all Application Servers in the cluster to
IMPAX 6.5.1.

Upgrading the ADAM database
If you are upgrading a cluster to Windows Server
2008, you must replicate the ADAM database
instance on a new Windows 2008 server, which
uses the AD LDS database.

Backing up the ADAM database
1. Select Start > All Programs >
Accessories > System Tools > Backup.

2. Select Tools > Options.

3. Switch to the Exclude Files tab.

4. In the list of file names, select C:\Program
Files\Microsoft ADAM and click Remove.
Click OK.

5. When the Backup or Restore Wizard is
displayed, clear the Always start in
Wizard mode checkbox and click
Advanced Mode.

6. On the Welcome screen, click Backup
Wizard.

7. On the Backup Wizard screen, click Next.

8. On the What to Backup screen, select
Backup selected files, drives, or
network data. Click Next.

9. On the Items to Backup screen, select the
folder containing the ADAM data as well as
theWorld Wide Web Publishing Service
folder. Click Next.

10. If backing up to a tape drive, under Backup
media type, select the tape drive, and in the
backup media area, click Newmedia. Click
Next.

or

If backing up to any other media type, select
the location where the backup is to be
saved, and type a name for the backup.
Click Next.

11. On the Completing the Backup Wizard
screen, click Advanced.

12. On the Type of Backup screen, select
Normal. Click Next.

13. On the How to Backup screen, select Verify
data after backup and Use hardware
compression if available. Click Next.

14. On the Backup Options screen, select
Replace the existing backups. ClickNext.

15. On the When to Backup screen, select Now.
Click Finish.

16. In the Backup Progress dialog, click Close.

17. Close the Backup Utility.

Stopping services on the
Application Servers
1. On an Application Server, open the Windows

Administrative Tools and select Services.

2. In the list of services, highlight the World
Wide Web Publishing Service.

3. Click Stop.

4. Repeat steps 2 and 3 for the following
services:

a. IMPAX Distributed License
Manager

b. IMPAX Messaging Service

c. IMPAX App Server Data Manager

d. IMPAX Audit Event Log Manager

e. IMPAX Dicom Object Sender

f. AGFA HealthCare Service

Uninstalling IMPAX 6.2
documentation
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Under Currently installed programs, select
IMPAX 6.2 Documentation.

4. Click Change/Remove.

5. In the Confirmation dialog, click OK.

6. In the Maintenance Complete dialog, click
Finish.

7. Under Currently installed programs, select
IMPAX Application Server Knowledge
Base.

8. Click Change/Remove.

9. In the Confirmation dialog, click OK.

10. In the Maintenance Complete dialog, click
Finish.

11. Under Currently installed programs, select
Impax Client Knowledge Base.

12. Click Change/Remove.

13. In the Confirmation dialog, click OK.

14. In the Maintenance Complete dialog, click
Finish.

15. Under Currently installed programs, select
IMPAX Server Knowledge Base.

16. Click Change/Remove.

17. In the Confirmation dialog, click OK.

18. In the Maintenance Complete dialog, click
Finish.

Uninstalling IMPAX 6.3 or later
documentation
1. Open Control Panel.

2. In Windows 2008 Service Pack 2, select
Programs and Features.

3. In the Programs and Features dialog, under
Currently installed programs, select AGFA

© Copyright 2011 Agfa HealthCare N.V., Septestraat 27, B-2640, Mortsel, Belgium
14 June 2011 13 / 21



IMPAX version Knowledge Base
buildnumber Documentation.

4. Click Remove.

5. In the confirmation dialog, click OK.

6. Close the Programs and Features dialog.

Uninstalling the IMPAX
Installation Server
1. Open Control Panel.

2. In Windows 2008 Service Pack 2, select
Programs and Features.

3. Select Agfa IMPAX Installation Server
version_number where version_number
is the version of the installed Installation
Server.

4. Right-click and select Uninstall.

Determining the version of the
installed Oracle Client
1. Open a command prompt.

2. Type

sqlplus -V

Removing ODBC entries prior to
uninstalling the Oracle Client
1. Open the Windows Administrative Tools and

select Data Sources (ODBC).

2. In the ODBC Data Source Administrator
screen, select the System DSN tab.

3. For each driver listed, select the associated
name and click Remove.

4. Click OK.

Uninstalling the previous version
of Oracle Client
1. Select Start > All Programs > Oracle -
ohome > Oracle Installation Products
> Universal Installer.

2. Click Deinstall Products.

3. In the Inventory dialog on the Contents tab,
select the OraClient10_home1 checkbox,
where home1 can be any text.

4. Click Remove.

5. In the Confirmation dialog, to confirm the
uninstall, click Yes.

6. After the uninstall is complete, to close the
Universal Installer, click Close, then Cancel.

7. Open the Windows Administrative Tools and
select Services.

8. Select the Distributed Transaction
Coordinator service. If it started, click Stop
to stop it.

9. From Windows Explorer, delete the
drive_letter:\oracle directory.

10. From Windows Explorer, delete the
C:\Program Files\Oracle directory.

11. Run regedit and delete the
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE
key.

12. Restart the computer.

Installing and configuring the
Oracle 10g Client for Windows
1. Insert the IMPAX Oracle for Windows 32-bit

DVD.

2. From the DVD drive, run setup.bat.

3. At the Install Oracle "client" or
"server"? prompt, type client.

4. At the Hostname of the Oracle server
[] ? prompt, type the correct host name of
the IMPAX Database Server.

5. At the What machine is the repository
host? [localhost] prompt, if it is the
localhost, press Enter. Otherwise, specify
the appropriate IP address.

6. At the Where is the software
repository? prompt, if installing from the
DVD drive on F, press Enter. Otherwise,

type the DVD drive or software repository
directory.

7. At the Where is the temporary work
directory? [ C:\cygwin\temp] ? prompt,
click Enter to accept the default location.
Otherwise, type the directory to use.

8. After the Oracle installation complete
message appears, restart the server.

Setting up a connection to the
Oracle database
1. If the Net Configuration Assistant is not

open, select Start > All Programs >
Oracle - ohome > Configuration and
Migration Tools > Net Configuration
Assistant.

2. In the Oracle Net Configuration Assistant
Welcome dialog, select Local Net Service
Name configuration and click Next.

3. If the Naming Methods Configuration dialog
appears, select Local Naming. Click Next.

4. In the Net Service Name Configuration
screen, select Add. Click Next.

5. In the Service Name field, type MVF. Click
Next.

6. From the list of protocols, select TCP. Click
Next.

7. In the TCP/IP dialog, type the hostname of
the Oracle server.

8. Accept the default port number (1521). Click
Next.

9. Select Yes, perform a test. Click Next.

10. Click Change Login.

11. In the Username field, type mvf, and type
the password for the mvf user.

12. Click OK.

13. Click Next.

14. In the Net Service Name field, ensure that
MVF.world appears. Click Next.
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15. If you do not want to add a net service name
for RIS, select No. Click Next.

or

To add a net service name for RIS, at the
prompt to configure another net service
name, select Yes. Click Next. Then repeat
all previous steps using a different service
name (for example, qprod), as well as a
different host name, login, and net service
name (for example QPROD.WORLD).

16. In the Net Service Name Configuration
Complete dialog, click Next.

17. In the Naming Methods Configuration
Complete dialog, click Next.

18. To close the Net Configuration Assistant
dialog, click Finish.

Reconfiguring ODBC data source
names
1. Open the Windows Administrative Tools.

2. Select Data Sources (ODBC).

3. Switch to the System DSN tab.

4. Click Add.

5. In the Create New Data Source dialog, select
Oracle in Oracle_instance_name

6. Click Finish.

7. In the Data Source Name field, type mvf.

8. Type a description, if needed.

9. In the TNS Service Name field, type
MVF.world.

10. In the User Name field, type mvf.

11. To save the changes and close the dialog,
click OK.

12. To save the new sources and exit the ODBC
Data Source Administrator dialog, click OK.

13. If reconfiguring the Application Server,
repeat the previous steps for the mvf_ora
DSN as well.

Upgrading to the 10.2.0.4 version
of the Oracle Client for Windows
1. Insert the Oracle on Windows 32-bit DVD.

2. Open a command prompt.

3. Change to the C:\mvf-mig6\bin directory.

4. Type bash upgrade-oracle
location_of_DVD_drive_or
_Oracle_software_repository

5. When you see the message Ready to
upgrade Oracle using repository Oracle
software location. Do you want to
proceed? [y/n], verify that the oracle
software location is correct. If the location
is correct, type y and press Enter.

Upgrading the IMPAX Application
Server software to 6.5.1
1. Insert the IMPAX Business Services CD.

2. Navigate to the CD ROM drive, which
contains the Business Services software.

3. Run AGFA IMPAX Business Services
Setup.exe.

4. Click Install.

5. On the Welcome screen, click Next.

6. On the license agreement screen, select I
accept the terms in the license
agreement. Click Next.

7. On the Web Services Installation Folder
screen, click Change.

8. Set the path to the wwwroot directory so
that it matches the pre-upgrade installation
location. Click OK.

9. Click Next.

10. On the Setup Type screen, select Custom.
Click Next.

11. If you have an IMPAX RIS to connect to,
click RIS Web Services and select This
feature will be installed on local hard
drive.

12. If you are using SmartCard authentication,
verify that NHS SmartCardWeb Services
is selected. If it is not selected, select it.
Select This feature will be installed on
local hard drive.

13. Click Next.

14. Click Install.

15. On the InstallShield Wizard Completed
screen, select Launch IMPAX Business
Services Configuration tool. Click Finish.

16. When the message Previous
configuration found from version
6.X.X... appears, click Yes. This message
is not displayed when upgrading from IMPAX
6.5 to IMPAX 6.5.1.

17. In the Configuration Tool, click Apply.

18. To close the Configuration Tool, click OK.

Installing the IMPAX
documentation
1. Insert the IMPAX Documentation DVD.

2. From the DVD root, double-click
IMPAXDocumentationSetup.exe.

3. On the Welcome screen, click Next.

4. On the Setup Type screen, select the
appropriate option and click Next.

5. If you selected Select Documentation to
Install, on the Choose Features screen, you
can select particular Knowledge Bases or
languages to install.

6. On the Ready to Install the Program screen,
click Install.

7. On the InstallShield Wizard Completed
screen, click Finish.

Running the IMPAX Installation
Server package
1. From the IMPAX Client CD or a network

location, run
IMPAXInstallationServerSetup.exe.
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2. On the Welcome to the InstallShield Wizard
for IMPAX Installation Server screen, click
Next.

3. To install the application into
C:\Inetpub\wwwroot\ClientInstaller, on the
Destination Folder screen, click Next.

or

To install the application to another location,
click Change. In the Change Current
Destination Folder dialog, browse for the
directory location to install into and click
OK. On the Destination Folder screen, click
Next.

4. On the Ready to Install the Program screen,
click Install.

5. On the Installation Wizard Completed
screen, click Finish.

6. On the second Installation Wizard Completed
screen, click Finish.

Running Healthcheck from a URL
to check the status of web
services
1. Ensure that the Healthcheck web.config file

has been configured to the site’s needs.

2. On the Application Server, launch Internet
Explorer.

3. In the address bar, if Healthcheck has not
been configured to automatically log in, type

https://fully_qualified_domain_name/
AgfaHC.Healthcheck.Escrow

or

https://fully_qualified_domain_name/
AgfaHC.Healthcheck.Escrow/
EscrowForm.aspx

4. If Healthcheck has not been configured to
automatically log in, type an IMPAX
Administrator username and password,
select the login domain, and click Log in.

5. To determine what the problem is for any
web services with the status Failed, review
the Comments.

6. To check the status of the web services
again, in Internet Explorer, click Refresh.

Upgrading additional Application
Servers in the cluster
1. Upgrade the IMPAX Application Server

software.

2. Verify the installation.

Upgrading the AD LDS database
from IMPAX 6.5 to IMPAX 6.5.1
Unlike previous versions of the IMPAX Application
Server, the AD LDS database must be migrated
when upgrading from IMPAX 6.5 to 6.5.1. The
migration is performed automatically during the
software upgrade.

Creating a one-time backup of AD
LDS
1. To open an elevated command prompt, click
Start, right-click Command Prompt and
select Run as administrator.

2. At the command prompt, type

dsdbutil

3. At the dsdbutil prompt, type

activate instance AgfaHealthcare

4. At the dsdbutil prompt, type

ifm

5. At the ifm prompt, type

create full location

6. At the ifm prompt, type

quit

At the dsdbutil prompt, type

quit

Stopping services on the
Application Servers
1. On an Application Server, open the Windows

Administrative Tools and select Services.

2. In the list of services, highlight the World
Wide Web Publishing Service.

3. Click Stop.

4. Repeat steps 2 and 3 for the following
services:

a. IMPAX Distributed License
Manager

b. IMPAX Messaging Service

c. IMPAX App Server Data Manager

d. IMPAX Audit Event Log Manager

e. IMPAX Dicom Object Sender

f. AGFA HealthCare Service

Uninstalling IMPAX 6.3 or later
documentation
1. Open Control Panel.

2. In Windows 2008 Service Pack 2, select
Programs and Features.

3. In the Programs and Features dialog, under
Currently installed programs, select AGFA
IMPAX version Knowledge Base
buildnumber Documentation.

4. Click Remove.

5. In the confirmation dialog, click OK.

6. Close the Programs and Features dialog.

Uninstalling the IMPAX
Installation Server
1. Open Control Panel.

2. In Windows 2008 Service Pack 2, select
Programs and Features.

3. Select Agfa IMPAX Installation Server
version_number where version_number
is the version of the installed Installation
Server.
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4. Right-click and select Uninstall.

Upgrading the IMPAX Application
Server software to 6.5.1
1. Insert the IMPAX Business Services CD.

2. Navigate to the CD ROM drive, which
contains the Business Services software.

3. Click Install.

4. On the Welcome screen, click Next.

5. On the license agreement screen, select I
accept the terms in the license
agreement. Click Next.

6. On the Web Services Installation Folder
screen, click Change.

7. Set the path to the wwwroot directory so
that it matches the pre-upgrade installation
location. Click OK.

8. Click Next.

9. On the Setup Type screen, select Custom.
Click Next.

10. If you have an IMPAX RIS to connect to,
click RIS Web Services and select This
feature will be installed on local hard
drive.

11. If you are using SmartCard authentication,
verify that NHS SmartCardWeb Services
is selected. If it is not selected, select it.
Select This feature will be installed on
local hard drive.

12. Click Next.

13. Click Install.

14. On the InstallShield Wizard Completed
screen, select Launch IMPAX Business
Services Configuration tool. Click Finish.

15. In the Configuration Tool, click Apply.

16. To close the Configuration Tool, click OK.

Installing the IMPAX
documentation
1. Insert the IMPAX Documentation DVD.

2. From the DVD root, double-click
IMPAXDocumentationSetup.exe.

3. On the Welcome screen, click Next.

4. On the Setup Type screen, select the
appropriate option and click Next.

5. If you selected Select Documentation to
Install, on the Choose Features screen, you
can select particular Knowledge Bases or
languages to install.

6. On the Ready to Install the Program screen,
click Install.

7. On the InstallShield Wizard Completed
screen, click Finish.

Running the IMPAX Installation
Server package
1. From the IMPAX Client CD or a network

location, run
IMPAXInstallationServerSetup.exe.

2. On the Welcome to the InstallShield Wizard
for IMPAX Installation Server screen, click
Next.

3. To install the application into
C:\Inetpub\wwwroot\ClientInstaller, on the
Destination Folder screen, click Next.

or

To install the application to another location,
click Change. In the Change Current
Destination Folder dialog, browse for the
directory location to install into and click
OK. On the Destination Folder screen, click
Next.

4. On the Ready to Install the Program screen,
click Install.

5. On the Installation Wizard Completed
screen, click Finish.

6. On the second Installation Wizard Completed
screen, click Finish.

Running Healthcheck from a URL
to check the status of web
services
1. Ensure that the Healthcheck web.config file

has been configured to the site’s needs.

2. On the Application Server, launch Internet
Explorer.

3. In the address bar, if Healthcheck has not
been configured to automatically log in, type

https://fully_qualified_domain_name/
AgfaHC.Healthcheck.Escrow

or

https://fully_qualified_domain_name/
AgfaHC.Healthcheck.Escrow/
EscrowForm.aspx

4. If Healthcheck has not been configured to
automatically log in, type an IMPAX
Administrator username and password,
select the login domain, and click Log in.

5. To determine what the problem is for any
web services with the status Failed, review
the Comments.

6. To check the status of the web services
again, in Internet Explorer, click Refresh.

Upgrading additional Application
Servers in the cluster
1. Upgrade the IMPAX Application Server

software.

2. Verify the installation.

Migrating an Application Server
from a Windows 2003 server to a
Windows 2008 server
All Application Servers in the same cluster must
be running the same operating system—either
Windows Server 2003 or Windows Server 2008.
When migrating from Windows 2003 to Windows
2008, you must replicate the ADAM data on the
Windows 2003 server to the AD LDS database on
the new Windows 2008 server.
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Configuring the Audit Record
Repository database connection
1. On the IMPAX Database Server, open a

command prompt or terminal window.

2. Change to the C:\mvf\bin (AS300) or
/usr/mvf/bin (AS3000, logged in as mvf
user) directory.

3. Type clui.

4. To check if the entry already exists in the
database, type

5. If the entry exists, to update the entry, type

Uninstalling the previous IMPAX
software packages
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Under Currently installed programs, select
Agfa IMPAX 6.2 version , Agfa
IMPAX 6.3 version , or Agfa
IMPAX AS300 (used for IMPAX 6.4 and
later).

4. Click Change/Remove.

or

For uninstalling IMPAX 6.4 and later, click
Remove.

5. When prompted, type your name (minimum
three characters). Click Next.

6. In the Confirmation dialog, click OK or Yes.

7. On the Maintenance Complete screen, click
Finish.

8. Restart the server.

Installing the Curator and CD
Export server software
1. Insert the IMPAX AS300 DVD.

2. Navigate to D:\programs\mvf and
double-click as300-installer.exe.

3. Type your name (minimum three
characters).

4. On the Welcome screen, click Next.

5. Clear the Database Packages checkbox.

6. Clear the Archive Packages checkbox.

7. Select the Optional Packages label and
select the appropriate packages.
MVFCurator must stay selected.
MVFcdexport is also required except,
perhaps, on slave Curators.

8. Click Next.

9. Browse to the location of the portable
password file and click OK.

10. Type the temporary password used to create
the portable password file and click Next.

11. On the Summary screen, click Next.

12. After all the packages have been installed,
click Yes, I want to restart my computer
now.

Manually uninstalling the IMPAX
6.2 or later Client software
(optional)
1. If running, log out of the IMPAX Client and

close the Login window.

2. Open Control Panel.

3. Select Add or Remove Programs.

4. Under Currently installed programs, select
AGFA IMPAX Client build_number .

5. Click Remove.

6. When asked to confirm the removal, click
Yes.

Installing the IMPAX Client
1. From the IMPAX Client CD or the

IMPAX Client Installation web page
(https://install_server_name/clientinstaller/
language_code), start the IMPAX Client
installation program,
IMPAXClientSetup.exe.

2. If a File Download dialog appears, click
Open or Run.

3. If a prompt appears about downloading and
installing missing components, click OK.

4. Follow the prompts to download and install
Microsoft .NET Framework 3.5, Microsoft
.NET Framework 3.5 SP1, or all.

5. On the Welcome to the InstallShield Wizard
for IMPAX Client screen, click Next.

6. On the License Agreement screen, read the
license agreement. If you agree, select I
accept the terms in the license
agreement. Click Next.

7. To install the application into C:\Program
Files\Agfa\IMPAX Client, on the Destination
Folder screen, click Next.

or

To install the application to another location,
click Change. In the Change Current
Destination Folder dialog, browse for the
directory location to install into and click
OK. On the Destination Folder screen, click
Next.

8. On the IMPAX Application Server screen, in
the Get or confirm application server name
field, type the fully qualified domain name
of the Application Server to use. Click Next.

9. On the IMPAX Login Type screen, select the
appropriate authentication method:
Windows, IMPAX, or Smart Card.

10. Click Next.

11. On the Ready to Install the Program screen,
click Install.

12. On the InstallShield Wizard Completed
screen, click Finish.

Redirecting studies to the
production server
If necessary, you can now configure the modalities
to redirect studies to the production server, rather
than the traveling server. How studies are
redirected is modality-specific and is not
documented in this publication.
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Migrating studies from the
traveling server
Using the Administration Tools or CLUI, you can
send the studies on the traveling server to the
production server.

Transmitting studies using the
Administration Tools
1. In Administration Tools, on the Daily tab,

click Study Manager.

2. Search for studies, and from the results list,
select the studies to transmit.

3. Click Transmit.

4. In the dialog, select the station you want to
transmit the study to.

5. Click Transmit.

Creating SEND jobs using CLUI
1. In CLUI, specify the list of studies to transfer

with the following command:

study send study_ref_1 study_ref_2 ...
study_ref_n destination

or

Generate the list of studies to transfer with
the following query:

save_refs a select study_ref from
dosr_study where column = constraint

2. Go to menu mode by typing go menu.

3. Select 1 for Study Manager, then 9 for
Send.

4. At the prompt for the list of studies to
process, enter a to reference the save_refs
list of studies.

5. At the prompt for the destination, enter the
destination.

Migrating a cache volume from a
flat to a hierarchical structure
1. At a command prompt on the system where

the cache volume is local, type

cache_migration.exe parameters
(Windows)

or

cache-migration parameters (Solaris,
logged in as mvf user)

Testing the installed software
1. On the IMPAX Database Server, run the

Administration Tools and ensure that you
can log in using the administration
password.

2. On the Application Server, open a web
browser and connect to http://localhost.
Ensure that the “Welcome to IMPAX” page
is displayed.

3. Run the IMPAX Client and ensure that you
can log in using the administration
password.

Restarting antivirus software
1. On a Windows server where scanning was

stopped, launch the antivirus software.

2. Start the scan operation according to the
vendor’s instructions.

Restarting Connectivity Manager
queues
1. In the Connectivity Manager Service Tools,

click Queue Manager.

2. In the Queue List table, select the checkbox
beside the queue of any system device or
real world device with a DM Out or
impax_report_server Component.

3. Click start.

Taking a post-upgrade system
snapshot
1. In a command prompt or terminal window,

change to the directory containing the
migration_inventory tool.

2. On a Windows server, type

migration_inventory -s -d
database_name -U
database_user_name -P
database_password -D
database_server_host_name

On a Solaris server, log in as mvf user and
type

./migration_inventory -s -d
database_name -U
database_user_name -P
database_password -D
database_server_host_name

3. To create a report file with this information,
in Windows, type

mig_reporter -t system_inventory_tool

In Solaris, type

./mig-reporter -t
system_inventory_tool

Comparing pre- and post-upgrade
snapshots
Open the report file that contains the pre- and
post-upgrade snapshot information. Compare the
pre- and post-upgrade information. Ensure that
all expected studies, objects, stations, and DICOM
printers are still listed.

Installing the PSARMT and cache
tools on a Solaris server
1. Log in as the root user.

2. Insert the IMPAX AS3000 DVD.

3. For the cache check and repair tools,
navigate to the
IMPAX_R6.5-impax_build_label directory.

4. To install the cache check and repair tools,
type pkgadd -d IMPAXcchk.

5. When asked to select packages, to install all
packages, press Enter.

6. When asked if you want to continue with the
installation, type y.
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7. For the PSARMT Migration Tools, navigate
to the IMPAX_R6.5-impax_build_label
directory.

8. To install the PSARMT Migration Tools, type
pkgadd -d IMPAXsrmt.

9. When asked to select packages, to install all
packages, press Enter.

10. When asked if you want to continue with the
installation, type y.

11. Remove the IMPAX AS3000 DVD.

Running PSARMT to mark studies
as PACS archived
1. Log in as the mvf or service user.

2. Change to the /usr/mvf/bin directory.

3. To build the PSARMT database tables in
IMPAX, run build-mvf-psarmt-database.

4. Specify the migration configuration by
running mvf-psarmt-config-manager.
Parameters are as follows:

5. Perform the migration, based on the
configuration defined in step 4, by running
mvf_psarmt.

6. Update the missing information in the
database from incoming study objects by
running mvf-study-fixer.

Detecting and correcting IMPAX
cache corruption
The Cache Check and Repair Tools are used to
identify missing cache files and to repair or
remove damaged ones. These tools are normally
run across all of the cache file systems on the
affected server, because files missing from a
damaged cache can sometimes be found on
another cache. Performance of the tools is
hardware-dependent.

Uninstalling the IMPAX Migration
Tools from a Windows computer
1. Open Control Panel.

2. On Windows 2003 servers, select Add or
Remove Programs.

On Windows 2008 servers, select Programs
and Features.

3. Select IMPAX 6.5.1 AS300 Migration
6.5.0.xxx

4. On Windows 2003 servers, click
Change/Remove. On Windows 2008
servers, click Uninstall.

5. In the Confirm File Deletion dialog, click
Yes.

6. At the Uninstall complete prompt, click
Finish.

Uninstalling the IMPAX Migration
Tools from a Solaris computer
1. Log in as the root user.

2. Type pkgrm IMPAXmigration.

3. Type y to remove the package.

4. Type y again to continue removing the
package.

Uninstalling the Cross-Cluster
Dictation Interlock tool
1. On the previous version IMPAX Application

Server where the Cross-Cluster Dictation
Interlock components were installed, open
the Windows Administrative Tools and select
Services.

2. Right-click the Impax Study Status Relay
service and select Stop.

3. Close the Services window by selecting File
> Exit.

4. Open a command prompt.

5. Change to the directory containing the
Cross-Cluster Dictation Interlock
components—possibly C:\Program
Files\Agfa\Impax Business Services.

6. Type
uninstall_study_status_relay_service.bat.

7. Close the command prompt by typing exit.

8. From Windows Explorer, navigate to and
delete the study-status-signal-relay
folder (possibly from C:\Program
Files\Agfa\Impax Business Services).

9. On the IMPAX 6.5.1 Application Server
where the 6.5.1 Cross-Cluster Dictation
Interlock components were copied, follow
steps 1 to 7.

10. Log into a previous version IMPAX Client as
an administrator user.

11. From the Configure area - Users and Roles
section, delete the remote-dictation user
from the Study Status Relay role, then
delete the Study Status Relay role.

12. Log into an IMPAX 6.5.1 Client as an
administrator user and repeat the previous
step on it.

Updating Heartlab polling
procedures
1. On the Database Server, log in as the
oracle user.

2. Run the following script from sqlplus:

update map_ini set ini_value = 'T'
where ini_key = 'HEARTLAB_ENABLED';

Synchronizing Windows servers
to an external time source
1. To open Registry Editor, select Start > Run,

type regedit, and click OK.

2. To change the synchronization server to
NTP, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
Parameters\Type subkey, change the
REG_SZ value from NT5DS to NTP.

3. To specify if the local machine is a local time
server, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
Config\AnnounceFlags subkey, change
the REG_DWORD value to 5.
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4. To enable the NTPServer, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
TimeProviders\ NtpServer\Enabled
subkey, change the REG_DWORD value to
1.

5. To specify where the computer obtains time
stamps, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
Parameters\ NtpServer subkey, enter the
list of DNS names or IP addresses.

6. To set the poll interval, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
TimeProviders\NtpClient\
SpecialPollInterval subkey, change the
REG_DWORD value to the number of
seconds between each poll.

7. To specify the maximum positive difference
that triggers a synchronization, in the
HKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
Config\MaxPosPhaseCorrection subkey,
change the REG_DWORD value to the
maximum number of seconds.

8. Similarly, to specify the maximum negative
difference that triggers a synchronization,
in theHKEY_LOCAL_MACHINE\SYSTEM\
CurrentControlSet\Services\W32Time\
Config\MaxNegPhaseCorrection subkey,
change the REG_DWORD value to the
maximum number of seconds.

9. Exit the Registry Editor.

10. To stop and restart the Windows Time
server, at a command prompt, type net
stop w32time && net start w32time.
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